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CHAPTER 1

About Film Composer and 
Media Composer

This chapter provides a general overview of the capabilities of 
Film Composer and Media Composer systems. It introduces basic 
concepts along with some tips for the beginning user in the following 
sections:

• Film Composer Overview

• About 24p Media

• About 25p Media

• Editing Basics

• From Flatbed to Desktop: Getting Oriented

• Project Workflow
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Film Composer Overview

Film Composer streamlines the editing process by combining the 
traditional tools of postproduction, the creative control of nonlinear 
digital editing, and the simplicity of the user interface.

n Since Film Composer shares a feature set with Media Composer models with 
the Universal Offline Editing option, Film Composer is used generically for 
an Avid film-based editing product throughout this chapter.

More than a method of saving time and money, nonlinear editing 
introduces a new style of craftsmanship into the postproduction suite 
by allowing greater experimentation in the composition of full-motion 
visual media.

Avid Film Composer blends the traditional benefits of previsualization 
familiar to the conventional film editor with the advanced production 
tools and image quality of high-end online production.

Film editors have long wanted access to the real-time effects and 
previsualization tools available in the online videotape suite, without 
losing their traditional sense of craftsmanship. The Film Composer 
nonlinear editing system makes this possible.

The nonlinear editing process is not new to film. In fact, you will 
discover many familiar terms and procedures of film editing 
preserved in this system. At the same time, Film Composer introduces 
random access to footage and the ability to easily create multiple 
versions of a cut.

This unique combination of traditional film concepts and 
state-of-the-art nonlinear technology dramatically shortens the 
distance between a concept and its execution in the cutting room, 
making the process of film editing more fluid. Film Composer 
includes new 24p and 25p editing technology which enables content 
producers to edit 24-frame progressive and 25-frame progressive 
content in its native format and to deliver NTSC, PAL, 4:3, 16:9, and 
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letterbox versions. It also outputs list formats such as film cut lists and 
24-fps and 25-fps edit decision lists (EDLs) for high-definition 
television (HDTV) conforming.

About 24p Media

With new digital television (DTV) formats expanding the options for 
content distribution, there is renewed interest in the oldest format in 
the industry: 24-fps film. In addition to its common format, film 
provides the highest resolution master for archiving purposes. 
Through a telecine transfer and the digitizing process, theAvid system 
captures and stores film frames as 24-fps progressive media, or 24p.

Progressive media is composed of single frames, each of which is 
vertically scanned as one pass. The Avid system creates 24p media by 
combining (deinterlacing) two video fields into a single, full, 
reconstructed frame. For NTSC film-to-tape transfers, the system 
creates 24p media by removing the extra fields inserted by the 2:3 
pulldown process and creating progressive frames.

Working in 24p simplifies digital editing of film or other 
24-fps-originated content, such as HDTV video that has been 
downconverted to ITU-R 601 digital video. In addition, 24p media 
requires less storage and processing power than 30-fps media. Because 
24p provides a common production format for multiversion, 
multiformat delivery, it promises to become the new universal format 
for all film and video content.



10

About 25p Media

The 25p format is primarily for use in countries where PAL video is 
standard. When you transfer 25-fps film footage to 25-fps PAL video, 
no modifications are necessary due to matching frame rates.

The 25-fps feature provides the following advantages:

• Simultaneous input of video and audio in sync

• Frame-accurate ink number tracking

• Digital cut recording directly to videotape 

• Frame-accurate cut lists and change lists

• Frame-accurate audio EDLs for online editing of audio tracks

• Frame-accurate EDLs for assembling footage from the transfer or 
for preparing an online show master

The source for 25p media is typically 25-fps film or 25-fps HDTV 
format. The methods for creating and storing 25p media are the same 
as for 24p media.

Editing Basics

The unique nature of nonlinear editing and the specific features of 
Avid Film Composer offer a new way of approaching the process of 
editing and the flow of your work on projects, as described in this 
section.

About Nonlinear Editing

As a digital, nonlinear editing tool, Avid Film Composer provides 
complete random access to footage, with instantaneous cueing and 
retrieval of sequences, segments, clips, and frames.
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In addition, traditional editing requires that you electronically copy 
video from a source tape to a master tape. When you make changes in 
this linear arrangement, you must reassemble all the clips that follow 
the change. By contrast, when you edit with Avid Film Composer, you 
are not actually cutting or dubbing the footage. Instead, you digitize 
your source tapes into media files that can be played just like the 
original tapes. When you edit, you work with these images and 
sounds (objects) with great freedom, creating data files that refer to the 
media files and to your original source tapes. You can make changes, 
and the entire sequence is immediately updated. This is the primary 
benefit of nonlinear editing.

The system maintains frame-accurate links between each alteration of 
the objects you work with and the original media files. This allows you 
to experiment with every edit you make through multiple generations. 
When you play back your work, the system immediately accesses and 
plays the appropriate portions of the digitized video and audio.

Editing Components

Knowing some basic terms for the editing components will help you 
use your Avid system more effectively:

• Project: The job that results in one or more sequences; the Project 
window organizes all the clips, sequences, effects, and media file 
pointers for a program or series of programs

• Sequence: An edited composition that includes audio and video 
clips and rendered effects

• Bin: The window in which you organize the material to be edited

• Source clip: The smallest media object that contains all the 
information necessary to reference footage

• Media file: Stored, compressed digital data representing the 
original video and audio
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• Source/Record mode: A mode composed of a Source monitor that 
displays source clips, a Record monitor that displays the 
assembled sequence, and controls for making basic edits

• Timeline: The graphical representation of every edit made to a 
sequence, including all nested effects and layered tracks

• Segment mode: Editing controls for moving, deleting, marking, 
and editing segments in the Timeline

• Trim mode: Controls for fine-tuning edits and transitions with 
various trim procedures

• Effect mode: Controls in the Timeline and the Effect Editor to 
apply, render, and edit effects into the sequence

• IN and OUT points: Starting and ending points of an edit

• Subclip: Part of a master clip, which references the master clip

• EDL: Edit decision list containing detailed information on your 
sequence for editing a videotape master

• Cut list: A series of output lists containing specifications used to 
conform the work print or negative

• Digital cut: A copy made directly from disk to tape

From Flatbed to Desktop: Getting Oriented

As a film editor, you have traditionally enjoyed the sensation of 
passing each frame of a project through your hands. When you rock a 
magnetic track back and forth, you can feel it vibrating at your 
fingertips. In addition, you are probably accustomed to judging edits 
based on the space that they occupy, using feet and frames as your 
guide.

The videotape editor, by contrast, is time-oriented, judging edits on 
the basis of the hours, minutes, and seconds dictated by timecode.
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Avid Film Composer integrates elements of both film and video 
editing:

• The Timeline, roughly modeled after the film synchronizer, and 
the edgecode tracking display (in feet and frames) preserves the 
spatial approach to editing.

• The timecode tracking display is based on the conventional 
time-oriented techniques of video postproduction.

Project Workflow

The following sections introduce the three stages of a project, along 
with the system terms you encounter when working with Avid 
Film Composer. Complete procedures for each stage are described in 
the printed manuals, online books, and Help for your Avid system.
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Starting a Project

1. Turn on your 
equipment in a 
prescribed order and 
start the application. 

2. Select or create a new 
project: the job that will 
result in one or more 
finished sequences.

3. Create and organize 
bins.

Starting a project involves the following steps:

2. Select or create a project.

3. Create and organize bins.

1. Turn on and start your Avid system.
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Editing a Sequence

1. View your clips in 
advance and mark IN 
points and OUT points, 
or create subclips based 
on selected portions of 
your master clips.

2. Build your sequence 
in Source/Record 
mode, which provides 
nonlinear editing 
controls with Source 
and Record monitors, 
and in the Timeline.

3. Fine-tune your edits 
and effects by using 
functions of the various 
edit modes, such as 
Segment mode, Trim 
mode, and Effect mode.

Editing a sequence involves the following steps:

1. Screen, mark, and subcatalog footage.

Timeline

2. Edit in Source/Record mode and in the Timeline.

IN point

Source 
monitor

Record 
monitor

3. Fine-tune edits and effects.
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Generating Output

Export and exchange 
material for audio 
sweetening or graphics 
enhancement in a 
third-party application, 
or for incorporating 
into a multimedia 
project.

Record the final 
sequence as a digital cut 
as NTSC or PAL, with 
16:9 or 4:3 screen ratio.

Generate a cut list to be 
used for conforming a 
film negative or work 
print.

Generate an EDL to 
create an HDTV online 
master.

Generating output based on your sequence involves any or all of the 
following options:

Export and exchange material for
import into third-party applications.

Record a digital cut directly to tape.

Generate an EDL for HDTV master.

Generate a cut list for film or work print.

Cut list



17

CHAPTER 2

Introduction

This chapter contains information to help you prepare for the tutorial 
chapters. This chapter contains the following sections:

• Using the Tutorial

• What You Need

• Turning On Your Equipment

• Installing the Tutorial Files

• How to Proceed

• Using Help

• Using Online Documentation

Using the Tutorial 

The self-paced tutorial included in this guide is designed as a guided 
Avid editing session, using the basic features of the system. In the 
tutorial, you edit a 1-minute commercial for Saturn® featuring chicken 
farmer and Saturn driver, Calvin Egg.

The footage for the sequence is on the Tutorial CD-ROM that came 
with your system. The CD-ROM contains digitized media ready for 
you to use.
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The instructions in the tutorial take you through each step of the 
editing process:

• Starting a project (in Chapter 3)

• Playing clips (in Chapter 4)

• Marking footage (in Chapter 5)

• Trimming (in Chapter 6)

• Creating a sequence (in Chapter 7)

• Refining the edit (in Chapter 8)

• Adding effects to a sequence (in Chapter 9)

• Adding a title to a sequence (in Chapter 10)

• Generating output (in Chapter 11)

To complete this tutorial, you need a basic familiarity with the 
Windows NT or Macintosh operating system. If you have never used a 
Windows NT or Macintosh system, see your Windows NT or 
Macintosh documentation.

You don’t need any previous experience with Avid systems to 
complete the tutorial. The terms and techniques needed for each 
tutorial section are in each chapter. You can use the Help system (see 
“Using Help” on page 22) and the online books (see “Using Online 
Documentation” on page 29) for more information. 

This tutorial takes approximately 3 hours to complete. 

Before you begin, you need an installed Film Composer or 
Media Composer system. If you have not yet set up your system, see 
the Avid Composer Products Setup Guide. If you need to install the 
software, see the Avid Media Composer and Film Composer Release 10.0 
Release Notes.
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What You Need

The Tutorial CD-ROM packaged with your Avid system includes all 
the files necessary to complete this tutorial:

• OMFI MediaFiles folder — Contains the digitized files you need 
for the tutorial. You need to copy these files to your external media 
drive.

• Avid Projects folder — Contains the project and bins you need for 
the tutorial. You need to copy these files to one of the following 
locations:

drive:\Avid\Avid Film Composer (Windows)

drive:\Avid\Avid Media Composer (Windows)

Avid drive (Macintosh)

Turning On Your Equipment

Begin your edit session by turning on the components of your Avid 
system. If any part of your system fails to turn on, make sure its 
electrical cord is plugged snugly into an appropriate electrical outlet 
or power strip. For information on setting up your system, see the Avid 
Composer Products Setup Guide.

c If you fail to follow the proper sequence for starting up your system, 
you could damage your computer or storage drives.

Always turn on the devices in the following order:

1. Fixed-storage drives: Turn on fixed-storage drives before starting 
the computer. Allow 10 to 15 seconds for the drives to spin 
up-to-speed before starting your computer. Allow 1 to 2 minutes 
for Fibre Channel drives.
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2. Other peripheral hardware: Turn on all other peripheral units 
except the computer. These include:

• Monitors and speakers

• Tape decks and additional autoassembly configurations 
(switcher, time-base corrector, and so on) if you plan to 
digitize or conduct an autoassembly

• Meridien™ I/O box

3. The computer: 

For information on 
Windows NT or 
Macintosh features, 
such as the desktop and 
icons, see your 
Windows NT or        
Macintosh 
documentation.

• Turn on your computer.

The computer goes through a self-check routine, and the 
startup screen appears.

c To avoid system damage, do not disconnect or turn off external 
drives while the system is on.

Installing the Tutorial Files

The Tutorial CD-ROM contains all the files you need for the tutorial 
sections of this guide. The CD-ROM contains the tutorial media files 
digitized at a 14:1 compression ratio. You need approximately 1 GB of 
free space available on your external media drive.

It takes approximately 15 minutes to install the media files from the 
CD-ROM to the external media drive. 
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How to Proceed

The following are a few tips for taking full advantage of Avid 
documentation and other resources:

• Complete the tutorial in this guide before starting a project.

• Begin learning about basic procedures by using the default 
settings. As your confidence increases, begin to explore additional 
procedures and settings.

• Instead of using the standard menus to find the command you 
need in a window, try using shortcut menus. Either right-click 
(Windows) or Option+click (Macintosh) in a window to access a 
menu that shows the most frequently used commands for that 
window.

• Keep the Avid Media Composer and Film Composer Quick Reference 
available during editing sessions to speed the use of shortcuts and 
keyboard commands. 

• Make a habit of reading Avid’s newsletters, mailings, and other 
trade publications.

• Make use of additional training resources provided by Avid 
whenever possible, such as classes and instructional videotapes. 
For more information, contact Avid at 800-867-2843.

• Check the Avid Web site for listings of courses, schedules, and 
locations:

www.avid.com/services/training/
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Using Help

You can get help and background information for tasks, windows, 
dialog boxes, and screen objects through your Avid Help system. Your 
Help system is HTML-based and operates in a Web browser. You need 
Version 4.5 or later of Microsoft® Internet Explorer. On a Macintosh 
system, Avid recommends Internet Explorer Version 5 or higher. For 
more detailed information on using Help, consult the Help system for 
your Avid product.

Setting Up Your Browser

You must have cookies enabled in your browser to use several 
capabilities of your Avid Help system. Avid does not retain personal 
information about you or your system other than your frequently 
visited Help topics.

To enable cookies:

1. Choose Internet Options from the Internet Explorer Tools menu.

2. Click the Security tab.

3. Click the Custom Level button.

4. Scroll down to the Cookies section.

5. Make sure the Enable button is selected.

6. Click OK, and then click OK again.

Opening and Closing the Help System

To open the Help system:

1. Choose Film Composer Help or Media Composer Help from the 
Help menu.

The Help system appears in the default browser for your system.
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2. Use the Using Help, Contents, Index, Search, Favorites, and 
Glossary buttons to access the information you need.

To close the Help system, do one of the following:

• Click the Close button (Windows) or the close box (Macintosh) in 
the browser.

• Choose Exit from the browser File menu.

• Navigate to another Web site.

Getting Help for Windows and Dialog Boxes

The Help system provides you with context-sensitive Help for 
windows and dialog boxes, such as tools and settings. 

To get Help for windows and dialog boxes:

1. Make sure the Avid application is active.

2. Position the mouse pointer anywhere in the window or dialog box 
for which you want help.

3. Press the F1 key (Windows) or the Help key (Macintosh) on the 
keyboard.

If there is no information about a window or dialog box, a 
Navigation Canceled message appears in the browser. Open the 
Help and use the Search or the Index function to look for 
information on that window or dialog box.

Getting Help for Screen Objects

You can use What’s This? Help to find out about buttons and other 
screen objects.
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To get help for screen objects:

1. Right-click (Windows) or Ctrl+Shift+click (Macintosh) the screen 
object.

2. Choose What’s This? from the shortcut menu.

A browser window opens that explains how you use the item. 
Many windows include a link (marked by underlined text) to 
more information.

n (Windows only) For some dialog boxes, such as Import and Print, use the 
Question Mark button to access What’s This? Help.

Keeping Help Available (Windows Only)

When you access a Help topic and then return to the Avid application, 
the Help browser disappears behind the Avid application.

You can restore the Help from the taskbar at the bottom of the screen. 
All your active applications are represented by buttons on the taskbar.

To restore Help, click the browser button on the taskbar.

The Help reappears.

If you can’t see the taskbar, you might have set a property that hides it.

To keep the taskbar on top:

1. Right-click in an area of the taskbar where there are no buttons.

2. Choose Properties from the shortcut menu.

The Taskbar Properties dialog box appears.

3. Select Always on top.

4. Deselect Auto hide.
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5. Click OK.

The taskbar remains visible at all times.

Finding Information Within the Help

You see the Help browser when you open Help from the Help menu. 
The left frame of the Help browser includes a Contents list and buttons 
for several other methods of finding information.

Using the Contents List

The Contents button provides a list of topics covering the entire Help 
system.

To view the Contents list, do one of the following:

• From the Help menu, choose Film Composer Help or 
Media Composer Help, and then click the Contents button.

• From a Help topic, click the Contents button.

To display a topic, double-click the topic title in the Contents list.

n The Contents displays only the top-level topics. Many entries link to 
subtopics with related information or procedures.

Using the Index

The Index button provides an alphabetized list of entries, like the 
index of a printed book.

To find topics by using the Index button:

1. From the Help menu, choose Film Composer Help or Media 
Composer Help and click the Index button, or click the Index 
button from a Help topic.



26

2. From the alphabet at the top, select the letter that begins the topic 
you want to find.

3. Scroll through the topics beginning with that letter until you find 
the topic you want.

4. Click the number to the right of the index entry. The number 
indicates how many topics that index entry has associated with it.

The topic opens in the right frame of the browser.

Using the Search Feature

The Search button lets you search the entire Help system for words or 
phrases and then lists topics that include those words or phrases.

To search for topics by using the Search button:

1. From the Help menu, choose Film Composer Help or Media 
Composer Help and click the Search button, or click the Search 
button from a Help topic.

2. In the text box, type the word or phrase that you want to find. You 
can type up to three words.

3. Press Enter (Windows) or Return (Macintosh) or click the Search 
button.

A list shows topics that contain the word or words for which you 
searched. 

n Do not type quotation marks or asterisks in the text box.

4. Click a topic in the list.

The topic opens in the right frame of the browser.
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Accessing Information from the Help Menu

In addition to the Help system, the Help menu in Avid Film Composer 
and Media Composer provides other types of online information. The 
following table describes the Help menu choices for Windows 
systems.

Table 2-1 Windows Help System Menu Items

Menu Item Description

Film Composer Help or 
Media Composer Help 

Starts the Help system.

Shortcuts Displays a list of topics that describe keyboard 
shortcuts for Avid application operations.

Online Books Displays the opening screen of the Avid Online 
Publications CD-ROM, if you have loaded the 
compact disc into your CD-ROM drive. The Avid 
Online Publications CD-ROM includes all software 
documentation in Adobe Acrobat Reader format. 
Use the opening screen to access any manual. For 
information on getting the best performance, click 
“Using This Collection.”

cDo not access a CD-ROM while you are 
running a time-critical operation, such as 
digitize, render, or play.

Show ToolTips Switches the display of pop-up descriptions for 
buttons and tools. You can set the time delay in 
the Interface Settings dialog box, which you 
access from the Settings scroll list in the Project 
window.

www.Avid.com Starts the Avid home page. From this page, you 
can access all kinds of information about Avid, 
including technical support.
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Table 2-2 describes the Help menu choices for Macintosh.

www.AvidProNet.com Starts AvidProNet.com™, Avid’s 
business-to-business Web community and 
services portal designed specifically for media 
creation professionals. The site offers news, a 
reference area, an interactive community area, an 
Exchange area, and direct links to Web-based 
stock media libraries. 

About Displays the name and version of the product, 
along with license information.

Table 2-1 Windows Help System Menu Items (Continued)

Menu Item Description

Table 2-2 Macintosh Help Menu Items

Menu Item Description

Shortcuts Displays a list of topics that describe keyboard 
shortcuts for Avid application operations.

About Balloon Help Provides an explanation of Balloon Help™.

Show Balloons Switches the display of pop-up descriptions for 
buttons and tools. 

Online Books Displays the opening screen of the Avid Online 
Publications CD-ROM, if you have loaded the 
compact disc into your CD-ROM drive. The Avid 
Online Publications CD includes all software 
documentation in Adobe Acrobat Reader format. 
Use the opening screen to access any manual. For 
information on getting the best performance, click 
“Using This Collection.”
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Using Online Documentation

The Avid Media Composer and Film Composer Products Online 
Publications CD-ROM includes:

• Avid Film Composer and Universal Offline Editing Getting Started 
Guide  (this book)

• Avid Media Composer and Film Composer Getting Started Guide for 
Video Editing

• Avid Media Composer and Film Composer Input and Output Guide

• Avid Media Composer and Film Composer Editing Guide

• Avid Media Composer and Film Composer Effects Guide

• Avid Products Collaboration Guide

cDo not access a CD-ROM while you are 
running a time-critical operation, such as 
digitize, render, or play.

www.avid.com Starts the Avid home page. From this page, you 
can access all kinds of information about Avid, 
including technical support.

www.AvidProNet.com Starts AvidProNet.com, Avid’s 
business-to-business Web community and 
services portal designed specifically for media 
creation professionals. The site offers news, a 
reference area, an interactive community area, an 
Exchange area, and direct links to Web-based 
stock media libraries. 

Film Composer Help or 
Media Composer Help

Starts the Help system.

Table 2-2 Macintosh Help Menu Items (Continued)

Menu Item Description
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• AvidNet Transfer Tool User’s Guide

• Avid EDL Manager User’s Guide

• Avid MediaLog User’s Guide

• Avid FilmScribe User’s Guide

•  Film Composer Help or Media Composer Help

The books are PDF files. You can view them with Adobe 
Acrobat Reader, which you can install from the CD-ROM.

The online version of the books enables you to:

• Navigate through books by using bookmarks and hyperlinks.

• Speed up information retrieval by performing keyword searches.

• Annotate the books with your own notes.

• Zoom in on a page, enabling closer review of text and images.

• Print any or all pages.

• View the books with full-color graphics.

• View movies that illustrate Avid effects.

n Avid gives you permission to print up to three complete copies of each book.
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CHAPTER 3

Starting a Project

In this chapter, you start the application and then select a user and a 
project.

n Before starting the tutorial, make sure you have installed the Tutorial files (see 
“Installing the Tutorial Files” on page 20).

This chapter contains the following sections:

• Starting the Application (Windows)

• Starting the Application (Macintosh)

• Creating a New User

• Selecting a Project

• Viewing Clips

Starting the Application (Windows)

To start the application:

1. Click the Start button.

2. Point to Programs.

3. Point to the Avid folder.
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4. Click Avid Film Composer or Media Composer.

After a few moments, the Open Project dialog box appears.

The Saturn project that you installed in the Avid Projects folder in 
Chapter 2 appears in the Projects scroll list.

Starting the Application (Macintosh)

To start the application:

1. Open the Avid drive by double-clicking the Avid drive icon.

2. Open the Film Composer or Media Composer folder.

3. Double-click the application icon or alias. 

After a few moments, the Open Project dialog box appears. You 
use this box to select or create a user and a project. 

The Saturn project that you installed in the Avid Projects folder in 
Chapter 2 appears in the Avid Projects list.
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Creating a New User

To open a project, you create a new user and select an existing project.

To create a new user:

1. Click the New User button in the Open Project dialog box.

The New User dialog box appears.

2. Type Editor and click OK. 

The Open Project dialog box reappears with Editor highlighted in 
the Users scroll list.

Selecting a Project

To select a project:

To get help for the 
Project window, click in 
the Project window and 
press F1.

1. Select Saturn from the Projects scroll list, and click OK.

The Project window opens. It displays the Saturn bin.
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2. Double-click the bin icon to open the Saturn bin.

This bin contains the clips of the source footage you need to build 
the Tutorial sequence.

Viewing Clips

The information in a bin can be viewed in the following ways:

• Text view displays columns of information about your clips.

• Frame view displays each clip as a single representative image.

• Script view displays each clip with an image and an area in which 
to enter text as part of a storyboard.

Bin icon
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Using Text View

Let’s look at Text view:

Text view is the default 
bin setting.

1. Click the Text View button (labeled T) in the lower left corner of 
the bin to view information about clips in the Saturn bin.

If the button is highlighted, you are already in Text view.

In Text view, you can rearrange the clips in the bin by sorting on a 
particular column. Let’s first sort by Start time, and then sort by 
Name so that the clips return to alphabetical order.

2. Click the Start heading in the bin.

3. Choose Sort from the Bin menu.

The clips are rearranged according to Start time.

Text view

Text View button

Frame View button
Script View button

 

Script viewFrame view

Bin Fast Menu button
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4. Click the Name heading in the bin and choose Sort from the Bin 
menu to resort the clips in alphabetical order.

Using Frame View

Frame view presents each clip as single picture frame, with the name of 
the clip. You can play back the footage in each frame, change the size 
of frames, and rearrange frames in any order within the bin.

Let’s look at Frame view:

1. Click the Frame View button (labeled F) in the lower left corner of 
the bin to see a picture-frame representation of each clip in the bin.

n The sorted order of clips does not carry over to Frame view.

2. Choose Enlarge Frame from the Edit menu.

3. If some clips are now off screen, choose Fill Window from the Bin 
menu.

The clips are arranged in neat rows and columns in the bin.

Column headings

Object icons

Text View button

Bin Fast Menu
button
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4. Click one of the clips, and press the L key (Play) on the keyboard.

The clip plays in the bin.

5. Press the space bar (Stop) to stop playing the clip.

Using Script View

Script view combines the features of Frame view with Text view and 
includes space for typing notes or script. The frames are displayed 
vertically on the left side of your screen with a text box to the right of 
each clip. Clip data is displayed above the text box.

Let’s look at Script view:

1. Click the Script View button (labeled S) in the lower left corner of 
the bin to see a picture-frame representation of each clip in the bin 
along with space for typing notes or script.

2. Click in the text box next to the Audio Track clip.

Frame View button
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3. Type This audio track includes both music and 
voiceover.

4. Click the Text View button (labeled T) to return to Text view.

You have completed this tutorial section. In Chapter 4, you’ll learn 
how to open and play a clip in the Source monitor.

Script View button
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CHAPTER 4

Playing Clips

In the this chapter, you display and play several clips in the Source 
monitor. This chapter contains the following sections:

• Opening a Clip in the Source Monitor

• Displaying Tracking Information

• Controlling Playback

Opening a Clip in the Source Monitor

When you double-click a clip in a bin, it is loaded by default into the 
Source monitor. You can also load a clip by dragging the clip icon from 
the bin to the Source monitor.

To open the CU chick clip, double-click the CU chick clip icon in the 
Saturn bin.

The CU chick clip is highlighted in the bin and appears in the Source 
monitor.
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Displaying Tracking Information
For detailed 
information on 
Tracking Format 
options, see the Avid 
Media Composer and 
Film Composer Editing 
Guide or Help.

Tracking information consists of any type of format used to identify 
clips, audio and video tracks, individual frames, or footage durations 
while you work. This information is updated continuously to reflect 
your current position in the footage. You can choose various 
alternative tracking formats from the Tracking Information menus.

To access the Tracking Information menu:

1. Click the Tracking Information display above the Source monitor.

 
Tracking
Information
display
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2. Choose TC 30 from the Tracking Information menu.

By default, when you are working on a film project, tracking 
information is presented as key numbers, in feet and frames. Since 
we are working on a TV commercial, we will display a second row 
of tracking information as 30-fps video timecode.

To display a second row of tracking information and set it as 30-fps 
video timecode:

1. Click in the Project window, and click the Settings button.

The Settings scroll list appears.

Tracking Information menuTracking Information display
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2. Double-click Composer.

The Composer Settings dialog box appears.

For detailed 
information on 
Composer Settings 
options, see the Avid 
Media Composer and 
Film Composer Editing 
Guide or Help.

3. Select Second Row of Info, and click OK.

The Composer Settings dialog box closes.

4. In the Source monitor, click the space above the Tracking 
Information display.

A second Tracking Information menu appears.

5. Choose the following from the Tracking Information menu:

• TC 30 from the third section of the menu and V1 from the 
TC 30 submenu



44

• Timecode from the bottom section of the menu

Now two rows of tracking information are displayed above the Source 
monitor. The top row displays 30-fps video timecode. The second row 
displays key numbers.

n Remember that although the system displays 30-fps timecode, you are editing 
24-fps timecode. 

Controlling Playback

There are several ways to move through footage in the Source monitor:

• Use the mouse to move the position indicator in the position bar to 
go to a specific position or drag it to scroll through a clip.

• Use the playback control buttons under the Source monitor.

• Use the playback control keys on the keyboard.

Video timecode
Key numbers
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Using the Position Bar and Position Indicator

You can quickly access frames within a clip that has been loaded into 
the Source monitor or move through the footage by using the position 
indicator that appears in the position bar under the Source monitor. 
You can move the position indicator within the position bar under the 
Source monitor by clicking anywhere in the position bar or by 
dragging the position indicator to the left or right.

n The speed with which you drag the position indicator determines the speed at 
which you move through the footage.

To move through the clip by using the position indicator:

1. Locate the vertical position indicator in the position bar under the 
Source monitor.

2. Drag the position indicator back and forth in the position bar to 
move through the clip.

3. Drag the position indicator to the left to go to the beginning of the 
clip.

4. Drag the position indicator to the right to go to the end of the clip.

n Notice that as you move through footage, the Tracking Information display 
updates frame by frame.

Position
indicator

Position
bar
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Controlling Playback with Playback Control Buttons

Let’s use the playback control buttons to look at another clip:

1. Double-click the Hopping Chicks clip in the Saturn bin.

The clip opens in the Source monitor.

2. Click the Play button under the Source monitor.

3. Click the Rewind button to go to the head frame of the clip.

4. Click the Step Forward button several times to move through the 
footage frame-by-frame.

5. Press and hold the Alt key (Windows) or Option key (Macintosh) 
while clicking the Step Forward button to step forward 8 (24p) or 
10 (25p) frames.

6. Click the Fast Forward button to go to the tail frame of the clip.

7. Click the Step Backward button repeatedly to step backward 
frame-by-frame.

PlayStep
Backward 

Fast
Forward 

Rewind Step
Forward 
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Controlling Playback with Playback Control Keys

The playback control keys on the keyboard allow you to play, step, 
and shuttle through footage at varying speeds. 

Now let’s play through the Sunflowers clip by using the playback 
control keys:

1. Click the Sunflowers clip in the Source monitor.

2. Press the L key (Play) on the keyboard to play forward at normal 
speed (24 or 25 fps).

3. Press the J key (Play Reverse) on the keyboard to play the clip 
backward at normal speed. 

4. Press the L key (Play) repeatedly to play the clip forward at 48, 72, 
120, and 192 fps (24p) or 50, 75, 125, and 200 fps (25p).

5. Press the J key (Play Reverse) repeatedly to play the clip backward 
at 48, 72, 120, and 192 fps (24p) or 50, 75, 125, and 200 fps (25p). 

6. Press the space bar (Stop) to stop playback at any point.

7. Press and hold the K key while you press and hold the L or J key 
to move forward or backward at slow speed (6 fps).

8. Use the 3 key (Step Backward) and 4 key (Step Forward) to step 
through the footage backward and forward in 1-frame increments.

Play 

Stop 

Play/Step/Shuttle Step Forward Home key
End key
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9. Press the 1 key and 2 key to step through the footage backward 
and forward in 8-frame (24p) or 10-frame (25p) increments.

10. Press the Home key to go to the beginning of the clip.

11. Press the End key to go to the end of the clip.

You have completed this tutorial section. In Chapter 5, you’ll learn 
how to mark footage in the Source monitor.
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CHAPTER 5

Marking Footage

In this chapter, you learn to mark footage, locate IN and OUT points, 
and create subclips in the Source monitor. This chapter contains the 
following sections:

• Marking Edit Points

• Creating Subclips

Marking Edit Points

Before making your first edit, you can mark the segments of the clips 
you want to use in your sequence in the Source monitor.

Marking footage with IN and OUT points allows you to choose which 
sections of a clip to include in a sequence.

There are two methods for marking IN and OUT points:

• Use the Mark IN and Mark OUT buttons under the Source 
monitor.

• Use the I key (Mark IN) and O key (Mark OUT) on the keyboard.
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Using the Mark IN and Mark OUT Buttons to Mark a Clip

Let’s first display clips in the Source monitor, and then mark several 
clips we’ll use when we edit the sequence:

1. Double-click the Cowboy clip to open it.

The clip name is highlighted in the bin, and the clip appears in the 
Source monitor.

2. Play the whole clip through once first to get a sense of the 
material.

3. Press the Home key to go to the beginning of the clip.

4. Play the clip by pressing the L key (Play), and press the space bar 
at the approximate place where the cowboy enters the frame. 

5. Use the Step Forward and Step Backward buttons under the 
Source monitor to locate the frame in which he is positioned 
directly below Calvin’s reflection in the rearview mirror.

6. Mark an IN point by clicking the Mark IN button under the Source 
monitor.

A white sawtooth pattern appears on the left edge of the frame.
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7. Step forward to the point just before the horse begins to leave the 
frame.

8. Mark an OUT point by clicking the Mark OUT button under the 
Source monitor.

A white sawtooth pattern appears on the right edge of the frame.
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n The system saves your IN and OUT points until you change them.

Using the Mark IN and Mark OUT Keys to Mark a Clip

Next, let’s mark the IN and OUT points for the Restaurant scene clip 
by using the Mark IN and Mark OUT keys on the keyboard.

1. Open the Restaurant scene clip by dragging it into the Source 
monitor.

You want to show only the moment in which the waitress serves 
Calvin his coffee.

2. Use the J-K-L keys to locate the frame in which the waitress begins 
to tip the coffeepot.

3. Mark an IN point by pressing the I key (Mark IN) on the keyboard.
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A white sawtooth pattern appears on the left edge of the mark IN 
frame.

4. Press the End key to go to the end of the clip.

5. Mark an OUT point by pressing the O key (Mark OUT) on the 
keyboard.

A white sawtooth pattern appears on the right edge of the mark 
OUT frame.

Using Timecode as Reference

You can also use timecode as your reference point when marking IN 
and OUT points.

1. Double-click the CU with coffee clip to display it in the Source 
monitor.
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2. Mark an IN point at 02:07:02:20 (24p) or 2:07:01:12 (25p).

3. Mark an OUT point at 02:07:04:14 (24p) or 2:07:03:11 (25p).

Using Timecode to Find a Frame
Whenever you use the 
numeric keypad, you 
must press Enter on the 
numeric keypad after 
you type the number.

If you know the timecode for the frame you want to mark, you can go 
to that frame instantly by typing it on the numeric keypad.

1. Double-click the Hopping Chicks clip to open it.

2. Using the numeric keypad, type 5422 (24p) or 708 (25p).

As you start typing, a window opens in the middle of the Source 
monitor, showing the numbers.

3. Press Enter on the numeric keypad. 
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When you press Enter, the position indicator locates the specified 
frame.

4. Mark an IN point.

5. Using the numeric keypad, type 5518 (24p) or 807 (25p) and 
press Enter.

6. Mark an OUT point.

Playing IN to OUT

Next, we’ll mark a clip and then take a look at the marked portion of 
the clip to make sure it is what we want:

1. From the bin, double-click the Zoom in Calvin clip.

2. Mark an IN point at 1:04:28:03 (24p) or 1:02:14:03 (25p).

3. Mark an OUT point at 1:04:30:00 (24p) or 1:02:16:02 (25p).

4. Press the 6 key (Play IN to OUT) on the keyboard.

The clip plays from the IN point to the OUT point.

Moving an OUT Point

It would be nice to provide a little more footage of Calvin petting the 
chicks before the next clip.

1. Press the W key (Go to OUT) on the keyboard.

The position indicator moves to the OUT point.

2. Alt+drag (Windows) or Option+drag (Macintosh) the OUT point 
until Calvin looks up into the camera at approximately 1:04:30:23 
(24p) or 1:02:16:12 (25p).
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3. Press the 6 key (Play IN to OUT) on the keyboard to review your 
edit.

The clip plays from the IN point to the OUT point.

Using Frame Offset

You can also use the numeric keypad to move the position indicator 
forward or backward a specified number of frames, with the frame 
offset feature. Let’s mark an IN point for the Car under bridge clip and 
then use frame offset to locate the OUT point:

1. Double-click the Car under bridge clip to open it.

2. Use the Play and Step buttons to locate the frame where the car 
appears to be directly under the bridge.

3. Mark an IN point.

4. To advance, type +61 and press Enter on the numeric keypad.

When using frame 
offset, type one frame 
fewer than the number 
of frames you want to 
advance.

5. Mark that frame as the OUT point.

6. Press the 6 key (Play IN to OUT) to view your edit.

Creating Subclips

When you mark footage with IN and OUT points, either you can save 
the entire clip along with the new marks, or you can create subclips 
based on the marks you set to break up longer master clips into 
smaller segments of selected footage. Creating subclips is a great way 
to organize your footage into manageable units.
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Let’s create two subclips from a single clip:

1. Double-click the Prairie landscape clip.

2. Scroll through the clip by clicking the Play button or by dragging 
the position indicator. 

Notice that there are two separate scenes that can be copied into 
separate subclips.

3. Mark an IN point at the beginning of the silo scene.

4. Mark an OUT point approximately halfway through the clip, 
about three-fourths into the silo scene.

5. Click the Clip icon next to the clip name in the upper left corner of 
the Source monitor, and drag the icon to the bin.

n As you begin dragging, the pointer changes to a hand attached to a small box.

A new item called Prairie Landscape.Sub.01 appears in the bin. 
The name is highlighted.

6. Type Silo and press Enter (Windows) or Return (Macintosh) to 
name the subclip.

7. With the Prairie landscape clip in the Source monitor, click the 
Clear Both Marks button under the Source monitor to remove the 
IN and OUT points.

8. Mark an IN point in the clip near the beginning of the field scene.

9. Mark an OUT point at the end of the clip.

10. Alt+click (Windows) or Option+click (Macintosh) the clip, and 
drag it from the Source monitor to the bin.

The clip name is highlighted in the bin.

11. Type Field and press Enter (Windows) or Return (Macintosh).

You’ve completed this tutorial section. In Chapter 6, you’ll learn how 
to edit marked clips into a sequence.
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CHAPTER 6

Creating a Sequence

In this chapter, you create and build a sequence by splicing clips in the 
Source monitor into the Record monitor. This chapter contains the 
following sections:

• Building a Sequence

• Navigating in the Timeline

• Adding Audio

• Reviewing the Sequence

Building a Sequence

You create a sequence by splicing a clip from the Source monitor into 
the Record monitor. Let’s use the WS prairie clip for the opening clip 
in the sequence:

1. Double-click the WS prairie clip to open it in the Source monitor.

2. Mark an IN point about 2 seconds into the clip.

3. Mark an OUT point 1:10 seconds later.

4. Click the yellow Splice-in button between the Source and Record 
monitors.
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The footage you marked in the Source monitor is displayed in the 
Record monitor and track V1 in the Timeline. You’ve just created a 
sequence consisting of a single clip.

Naming the Sequence

Your newly created sequence appears in the Saturn bin.

By default, the system names it Untitled Sequence.01. Let’s change 
this name:

1. Click the name Untitled Sequence.01 to select it; do not click the 
Sequence icon.

The name is highlighted.

2. Type Saturn Spot and press Enter (Windows) or Return 
(Macintosh).
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Using the Splice-in Key

Next, we’ll splice the Zoom in Calvin clip into the sequence:

1. Double-click the Zoom in Calvin clip in the bin to open it in the 
Source monitor.

2. Press the V key (Splice-in) on the keyboard.

The second clip is now edited into the sequence.
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Navigating in the Timeline

When you create a new sequence or load a sequence in the Record 
monitor, the sequence appears in the Timeline.

The Timeline provides various controls for quickly moving through a 
sequence and adjusting your view of details displayed in the tracks 
while editing.

The position indicator in the Timeline marks your place in the 
sequence. The Timeline’s position indicator is always in the same 
position as the Record monitor’s position indicator and works in the 
same way.

Let’s use the position indicator to move through the Timeline:

1. Move the position indicator to the beginning of the sequence by 
clicking in the left side of the Timeline.

2. Play through the first two clips.

3. Drag the position indicator through the footage at varying speeds.

n When you move the position indicator in the Timeline, the smaller position 
indicator within the Record monitor’s position bar also moves.

Timecode
tracks

Position indicator
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Splicing a Clip into the Middle of a Sequence

You can splice a clip anywhere in your sequence. Let’s see what the 
Car passing sign clip looks like between the first and second clips:

1. Open the Car passing sign clip in the Source monitor.

2. Mark IN and OUT points to mark 3 seconds of the car driving past 
the sign.

3. Ctrl+click within the Zoom in Calvin clip in the Timeline to move 
the position indicator to the first frame of the Zoom in Calvin clip.

4. Press the V key (Splice-in) on the keyboard.

n Wherever you splice a clip into the middle of a sequence, the rest of the 
sequence moves down. Splicing lengthens the material on the track.

5. Go to the head of the sequence and play through it to review your 
changes.

Undoing an Edit

The Car passing sign clip doesn’t seem to fit here. Let’s undo the last 
edit:

Choose Undo Splice-in from the Edit menu.

Use the Undo feature whenever you feel you have made a mistake or 
want to go back a step. You can undo or redo up to 32 previous actions 
listed in the Edit menu.

n You can also perform an Undo by pressing Ctrl+Z (Windows) or Alt+Z 
(Macintosh).
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Using the I/O (IN Point / OUT Point) Tracking Display

Let’s add two more clips to the sequence:

1. Open the Silo subclip.

2. Mark an IN point about one-fourth of the way through the clip.

3. Mark an OUT point 2 seconds later by following this procedure:

a. Choose I/O from the Tracking Information menu (under the 
top row of timecode) in the gray area above the Source 
monitor.

The I/O option displays the duration from the IN to OUT 
points. If you mark only the IN point, the I/O option displays 
the duration from the IN point to the position indicator.

b. Step forward until the I/O display reaches 2+00, and mark an 
OUT point.

4. Move the position indicator to the first frame of black after Zoom 
in Calvin.

5. Press the V key (Splice-in) on the keyboard to splice the clip into 
the Timeline as the third clip. 

6. Open the Field subclip.

7. Mark an IN point a little less than halfway through the clip.

8. Mark an OUT point 1 second later.

The I/O display reads 1+00.

9. Splice the Field subclip clip into the Timeline as the fourth clip.

10. Choose Dur from the Tracking Information menu.

11. Go to the head of the sequence, and play through it to see your 
work.
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Adding Audio

Next we’ll lay down the audio clip, which contains the sequence’s 
music and narration. You mark approximately 1 minute of the clip, 
which will be the duration of your finished sequence. 

Using Digital Audio Scrub to Locate an Audio Frame

Digital audio scrub enables you to locate a specific frame of audio. In 
this procedure, we use digital audio scrub to locate the first frame of 
music in the audio clip.

1. Double-click the Audio Track clip to open it.

The clip appears in the Source monitor.

n Because it is audio only, the clip appears as black.

2. Play the clip through once.

3. Press the Home key to go to the beginning of the clip.

4. Press the Caps Lock key to activate digital audio scrub.

5. Press the 3 and 4 keys (Step Backward and Step Forward) on the 
keyboard to locate the first frame of the music, and click the Mark 
IN button.

n When you use the Step keys, a frame of music or speech sounds scratchy or 
buzzlike. You might want to increase the volume of your speakers to hear the 
first frame of music.

6. Go forward exactly 1 minute by typing +10000 and pressing 
Enter on the numeric keypad.

7. Mark that frame as the OUT point.

8. Press the Caps Lock key again to deactivate digital audio scrub.
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n Always turn Caps Lock off after using digital audio scrub. Leaving Caps Lock 
on while editing can slow down your system.

Splicing an Audio Clip 

To splice the audio clip into the sequence:

1. Move the Timeline position indicator to the head of the sequence.

2. In the Timeline, deselect track V1; select tracks A1 and A2.

3. Click the yellow Splice-in button between the Source and Record 
monitors.

The audio track appears in tracks A1 and A2 of the Timeline. The 
sequence also appears in the Record monitor (the audio track 
appears black). 

Reviewing the Sequence

Let’s review the sequence:

1. Press the Home key to go to the head of the sequence.

2. Click the Play button under the Record monitor to play the audio.

This audio track should run the length of the sequence, and its 
duration should be approximately 1 minute.

You’ve completed this tutorial section. In Chapter 7, you’ll add 
additional clips to the sequence and will refine your edits.
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CHAPTER 7

Refining the Edit

Refining edits tightens and improves the relationship between 
pictures and sound. In this chapter, you add clips to the sequence by 
using storyboard editing. You then refine the sequence by rearranging 
several clips. This chapter contains the following sections:

• Overwriting Clips into a Sequence

• Using Storyboard Editing

• Rearranging Clips

• Removing Footage from a Sequence

Overwriting Clips into a Sequence

In addition to splicing, you can overwrite clips into a sequence. An 
overwrite edit replaces a section of a sequence with other source 
footage. An overwrite edit does not affect the length of the sequence.

The Field clip is a bit too long. In this section, we’ll edit the next clip 
into the sequence before the end of the Field clip:

1. In the Timeline, select track V1; deselect tracks A1 and A2.

2. Click the Record monitor’s top row of tracking information.

3. Choose TC 30 from the Tracking Information menu.
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4. Move the position indicator in the Timeline to the first frame of the 
Field clip by Ctrl+clicking between the Silo and Field clips.

5. Advance by typing +20 (24p) or +13 (25p) and pressing Enter on 
the numeric keypad.

6. Mark an IN point.

 

7. Open the CU chick clip. 

8. Mark an IN point in the first half of the clip, at the point where the 
chick appears to be in the center of the frame and looking straight 
into the camera, approximately 1:05:58:00 (24p) or 1:00:43:11 (25p). 

9. Mark an OUT point 1 second and 15 frames later when the chick 
looks sharply to the right.

10. Click the red Overwrite button between the Source and Record 
monitors.

c Don’t confuse the Overwrite button with the Lift/Overwrite button. 
The Overwrite button is located between the Source and Record 
monitors; the Lift/Overwrite button is located under the Timeline.

The clip overwrites the end of the Field subclip and extends 
beyond it, thus lengthening the video portion of the sequence.

You now have five video clips in your sequence.

 IN point
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Using Storyboard Editing

Storyboard editing allows you to set up a group of clips in a sequence 
of events and then load them into the Record monitor all at once.

To add multiple clips to your sequence:

1. Load Car LS down road into the Source monitor, and mark an IN 
point at 1:09:24:13 (24 p) or 1:02:31:22 (25p). 

2. Mark an OUT point at 1:09:27:17 (24p) or 1:02:34:24 (25p).

You’ve set the IN and OUT points for nine clips. We’ve set the rest 
for you.

3. Display the bin in Frame view.

4. Choose Fill Window from the Bin menu to arrange the clips in the 
bin.

5. Click the Car LS down road clip, and drag it to a clear space in the 
lower left area of the bin.

6. Arrange the following clips (after Car LS down road) in two or 
three rows, from left to right, and top to bottom, to form the 
storyboard. Make sure you maintain the order of clips:

• Hopping chicks

• Cowboy

• Car under bridge

• Car in pasture

• Restaurant scene

• CU with coffee

• Sunflowers

• Children run out

• Car drives into sunset

• Car passing sign

Frame View button



69

• Driver screen right

• Wagon over bridge

• Wagon angle past grain elevator

• CU climbing grain elevator

• Wagon drives into grain elevator

• Looking at chicks

• CU happy farmer

• Wagon LS down the road 

Now you’re ready to load the marked clips into the sequence.

7. Ctrl+click (Windows) or Option+click (Macintosh) in the Timeline 
near the end of the CU chick clip.
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8. Select the storyboarded clips all at once:

a. Move the mouse pointer in the bin to the blank area just to the 
left of the Car LS down road clip. 

b. Lasso the clips by dragging the pointer to the right and down, 
making sure to select all the storyboarded clips.

A box forms as you move the mouse, starting next to the Car 
LS down road clip and ending at the last pointer position. All 
the names are highlighted in blue.

9. Alt+click (Windows) or Option+click (Macintosh) one of the clips 
(the image, not the name), and drag the group into the Record 
monitor. 

10. Release the mouse when a yellow arrow appears in the Record 
monitor. 

The clips are spliced into the sequence in the order you specified. 

11. Move the position indicator to the head of the sequence, and play 
the entire sequence. 

Rearranging Clips

You can rearrange clips by overwriting material, lifting material, or 
removing material. Overwriting material doesn’t change the length of 
the sequence. Lifting material leaves filler and doesn’t affect the length 
of the sequence. Removing material shortens the length of the 
sequence.

Overwriting with the Three-Point Edit

The three-point edit is an excellent way to replace a clip in a sequence. 
Use the Mark Clip key to select the clip in the sequence, and mark 
either an IN point or an OUT point in the source clip. The system 
calculates the exact duration of the source clip to insert.
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Let’s replace the Car in pasture clip with Car with cows to create a 
more interesting visual image:

1. To enlarge this area, in the Timeline:

a. Press the Home key.

b. Click the scale box in the scale bar, and drag it to enlarge the 
Timeline.

c. Click the scroll box, and drag it to the right until you see the 
entire Car in pasture clip.

2. Move the position indicator to the Car in pasture clip.

3. Press the T key (Mark Clip) on the keyboard.

The IN and OUT points appear at the head and tail of the clip in 
track TC1 in the Timeline; the marked segment is highlighted. The 
IN and OUT points also appear in the Record monitor’s position 
bar.

4. Open the Car with cows clip in the Source monitor, and mark an 
IN point about 2 seconds into the clip.

5. Click the Overwrite button to make the three-point edit.

The Car with cows clip replaces the Car in pasture clip.

6. Return to the previous Timeline view by doing the following:

a. Click the scale box, and drag it to the left.

b. Move the position indicator in the Record monitor to the head 
of the sequence.

7. Play the sequence to see the change.
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Changing the Order of Clips in a Sequence

Let’s see what it looks like if we reverse the position of two clips in the 
sequence, Cowboy and Car under bridge:

1. Move the Timeline position indicator to the Car under bridge clip.

2. Click the Timeline Fast Menu button, and choose Heads from the 
View Type submenu.

The Timeline changes to Heads view. The Car under bridge clip is 
highlighted in blue.
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3. Press and hold the Alt key (Windows) or Option key (Macintosh), 
drag the Car under bridge clip to the left so it is directly in front of 
the Cowboy clip, and release the mouse button. 

Cowboy now follows Car under bridge.

4. Choose Default Setup from the Timeline Fast menu.

5. Click the head of the sequence, and review the edit. 

Removing Footage from a Sequence

You can remove footage from your sequence, and either close or retain 
the gap that results. Extract/Splice-in closes the gap, and Lift retains 
the gap.

Removing Footage and Closing the Resulting Gap

The Field clip is too static. Let’s remove it from the sequence and close 
the gap that results:

1. Click the yellow Segment Mode (Extract/Splice-in) button under 
the Timeline.

2. Click anywhere in the Field clip on track V1.

The clip is highlighted in purple.

3. Press the Delete key on the keyboard.

The selected clip is eliminated, and the surrounding clips close the 
gap.

4. Click the Extract/Splice-in button again to deselect the button and 
leave Segment mode.
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Removing Footage and Retaining the Resulting Gap

Lift retains the gap after lifting footage from the sequence. Use Lift if 
you want to maintain the rhythm of a sequence or the synchronization 
of the video and audio tracks.

The Children run out clip plays for too long. Let’s use Lift to shorten 
Children run out but maintain the same entrance point for the next 
clip:

1. Scroll through the Children run out clip, and mark an IN point as 
the third child appears at the left of the screen.

2. Ctrl+Alt+click (Windows) or Ctrl+Option+click (Macintosh) near 
the end of the Children run out clip to go to the last frame of the 
clip.

3. Mark an OUT point.

4. Click the Lift button under the Record monitor to remove the 
segment.

Later, we’ll determine what to put in its place.

You have completed this tutorial section. In Chapter 8, you’ll learn 
how to trim your sequence.
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CHAPTER 8

Trimming

For more information 
on Trimming, see the 
Avid Media Composer 
and Film Composer 
Editing Guide.

Trimming allows you to adjust incoming and outgoing frames of your 
clip. There are two types of trims: dual-roller and single-roller. This 
chapter contains the following sections:

• Dual-Roller Trimming

• Using Dual Rollers to Trim the Outgoing Clip

• Trimming the Windshield Clip

• Single-Roller Trimming

Dual-Roller Trimming

Dual-roller trims adjust both sides of a transition simultaneously, 
adding frames to one clip while subtracting frames from the adjacent 
clip. The total duration of the sequence does not change.

Let’s cut the Sunflowers clip so that it matches the pause in the 
narration:

1. Move the position indicator near the CU with coffee/Sunflowers 
transition, and click the Trim Mode button under the Timeline.

The position indicator snaps to the transition.
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The Record monitor shows the last (tail) frame of the CU with 
coffee clip, and the Source monitor shows the first (head) frame of 
the Sunflowers clip on the right.

New buttons appear below the trim windows.

2. Play the transition by clicking the Play Loop button.

The transition plays repeatedly.

3. To stop the playback loop, click the Play Loop button again.

4. Press the Caps Lock key on the keyboard so you can hear the 
audio as you trim.

Trim
transition

Outgoing video Incoming video

Frame
countersTrim frame buttons buttonPlay Loop
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To use digital audio scrub, make sure the Speaker icon on the 
Audio Track Monitor button is highlighted. Increase the speaker 
volume, if necessary.

5. If the Speaker icon is not highlighted, Alt+click (Windows) or 
Option+click (Macintosh) the A1 Audio Track Monitor button.

6. Click the Trim Right 1 Frame button under the Source monitor 
until you hear a pause in the narration immediately after Calvin 
says, “. . . some pretty rugged country” (24p) or ”. . . the 
Saskatchewan river . . .” (25p).

This adds frames to the tail of the outgoing clip and removes them 
from the head of the incoming one. The duration of the video track 
remains unchanged.

7. Play the transition again by clicking the Play Loop button.

8. Press the Escape key to exit Trim mode.

9. Press the Caps Lock key on the keyboard to turn off digital audio 
scrub.

Using Dual Rollers to Trim the Outgoing Clip

Let’s insert a clip to take the place of the filler we left in the sequence. 
You replace the filler with the Windshield clip. After we overwrite the 
clip into the sequence, we’ll trim it.

1. Move the position indicator within the filler between the Children 
run out and the Car drives into sunset clips.

2. Open the Windshield clip, and mark an IN point about halfway 
into the clip. Do not mark an OUT point.

 Speaker
 icon

Trim Right
1 Frame

Trim Left
1 Frame
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3. Click the red Overwrite button between the Source and Record 
monitors.

4. Click the Trim Mode button under the Timeline.

5. Use the Trim Left 1 Frame button to move the transition 5 frames 
earlier.

Trimming the Windshield Clip

In the next steps, you will trim the Windshield clip so it enters a little 
earlier.

1. Enter Trim mode by lassoing the Timeline tracks: 

a. Click the pointer above all the Timeline tracks just to the left of 
the Children run out/Windshield transition. 

b. Drag the mouse down and to the right to surround the
transition.

The trim rollers appear.

2. Move the transition 16 frames (24p) or 20 frames (25p) earlier by 
clicking the Trim Left 8 Frames (24p) or Trim Left 10 Frames (25p) 
button twice.

The numbers change in the purple frame counters.

3. Click the Play Loop button.

Trim rollers
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Single-Roller Trimming

In the trims you have made so far, you trimmed both the head and the 
tail clips an equal number of frames, adding to one side and 
subtracting from the other. Now let’s trim the tail of the Zoom in 
Calvin clip without affecting the head of the Silo clip. This is called 
single-roller trimming.

Let’s use single-roller trimming to edit your sequence:

1. While still in Trim mode, advance to the Zoom in Calvin/Silo 
transition by repeatedly pressing the A key on the keyboard.

2. Click the left frame counter (A-Side Trim counter).

Your trim will affect only the outgoing clip, which is in the left 
Trim monitor. The left frame counter remains purple, while the 
right one is deselected.

3. Type –15  and press Enter on the numeric keypad to subtract 15 
frames from the outgoing clip.

This moves the transition 15 frames to the left.

4. Advance to the CU chick/Car LS down road transition by 
pressing the S key on the keyboard twice.

5. Click the left frame counter (A-Side Trim counter), type +30 , and 
press Enter on the numeric keypad.

Thirty frames are added to the outgoing clip.

6. Leave Trim mode by clicking the Source/Record Mode button 
under the Timeline.

You have completed this tutorial section. In Chapter 9, you’ll learn 
how to add effects to your sequence.

Left frame
counter
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CHAPTER 9

Adding Effects

Avid Film Composer and Media Composer offer many effects that you 
can apply to your sequences. This chapter explains how to apply 
effects to transitions or segments (clips) in your sequence. After you 
have selected the effect and have applied it to a transition or segment, 
you can adjust the effect parameters to meet your requirements.

This chapter contains the following sections:

• Adding a Dissolve Effect (Fade In)

• Dissolving Between Clips

• Creating a Picture-in-Picture Effect

• Creating a Freeze Frame

• Screening the Sequence

Adding a Dissolve Effect (Fade In)

First we’ll add a Dissolve effect (fade in) to a transition. An effect that 
is applied between two clips is called a transition effect.

1. Click the head of the sequence.
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2. Click and hold the Fast Menu button between the Source and 
Record monitors.

The Tool palette appears.

3. Click the Add Dissolve button.

The Quick Dissolve dialog box appears.

4. Create a 20-frame dissolve (fade-in), starting at the cut by doing 
the following:

a. Choose Dissolve from the Add pop-up menu.

b. Choose Starting at Cut from the Position pop-up menu.

c. Type 10 in the Duration text box.

5. Choose the drive on which the effect media file should be stored 
from the Target Drive pop-up menu.

The default drive is the Effect Source Drive.
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6. Deselect the Skip Real-Time Effects check box.

7. Click Add and Render to render the effect.

The system creates the media file of the video effect during the 
rendering process. It also places an effect icon in the Timeline 
where you added the effect.

8. Play the effect. 

The sequence now begins with a fade-in to the WS Prairie clip.

Dissolving Between Clips

You can create a transition effect by adding a dissolve between the Car 
under bridge clip and the Cowboy clip.

1. Click the first frame of the Cowboy clip.

2. Click and hold the Fast Menu button between the Source and 
Record monitors.

The Tool palette appears.

3. Click the Add Dissolve button in the Tool palette. 

The Quick Dissolve dialog box appears.

4. Create a 10-frame dissolve, centered on the cut by doing the 
following:

a. Choose Dissolve from the Add pop-up menu.

b. Choose Centered on Cut from the Position pop-up menu.

c. Type 10 in the Duration text box.

5. Choose the drive on which the effect media file should be stored 
from the Target Drive pop-up menu.

6. Click Add and Render to render the effect.

7. Play the effect. Press the space bar to stop playback.
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Creating a Picture-in-Picture Effect

Now we’ll add a Picture-in-Picture effect, so that the odometer 
appears on-screen when Calvin mentions how many kilometers he has 
traveled in his Saturn. 

A Picture-in-Picture effect is a multilayer segment effect. This means 
that the effect is applied to the top layer of segments that contain two 
or more video tracks that will be played simultaneously.

This effect takes up two video tracks: V1 for the clip of the car and V2 
for the odometer clip. First, you have to move the Odometer clip to 
track V2.

1. Double-click the Odometer clip to open it in the Source monitor.

2. Click in the Timeline and add a new video track by choosing New 
Video Track from the Clip menu.

3. Deselect the V1 Track Monitor button.

4. Click the V1 Source Track button, and drag it to the V2 Record 
Track button.

5. Use the Step buttons under the Record monitor to move the 
position indicator about 10 frames into the Car under bridge clip.

6. Click the yellow Splice-in button between the Source and Record 
monitors.

The clip appears on track V2.

7. Choose Effect Palette from the Tools menu.

8. Click the Blend category.

The Blend effects, including Picture-in-Picture, are displayed in 
the right pane.
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9. Move the position indicator to the Car under bridge clip on track 
V2.

10. Click the Picture-in-Picture Effect icon in the Effect Palette and 
drag it to the Odometer clip on track V2.

The Effect icon appears in the Timeline, and the odometer appears 
in a box midscreen.

Effect icon

Foreground
image (V2)

Background
filler (V1)
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Repositioning the Image

Let’s move the image:

1. Click the Effect Mode button to enter Effect mode.

Parameters for the Picture-in-Picture effect appear in the Effect 
Editor.

2. Click the image of the odometer. 

Drag handles (the dots at the edges and in the middle of the box) 
appear, and a white hand appears when the pointer is over a 
handle.

3. Click the drag handle in the middle of the picture, and drag the 
image to the lower half of the screen.

Adjusting Softness

Now let’s use one of the Picture-in-Picture parameters to soften the 
edge of the image.

1. Click the Soft slider in the Effect Editor.

You can also type 20 on 
the numeric keypad.

2. Drag the Soft slider to the right to a value of 20. 
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Cropping the Image

Now let’s use another of the Picture-in-Picture parameters to crop the 
image:

1. Click the Crop triangular opener in the Effect Editor.

2. Set the following parameters for the Crop sliders:

• Top: 130

• Bottom: –590

• Left: 200

• Right: 0

Adding Keyframes

To add dissolves within the Picture-in-Picture effect, you need to add 
keyframes. These let the system know this is the location in the 
Picture-in-Picture effect where you want to start the dissolve.

To add keyframes:

1. Click the V1 Record Track button.

2. Click the first keyframe in the Record monitor.

3. Drag the Foreground Level slider all the way to the left to 
display 0.

4. Click in the Record monitor, and type +5 on the numeric keypad. 
Press Enter on the numeric keypad to move the position indicator 
5 frames after the first keyframe.
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5. Click the Add Keyframe button in the Effect Editor.

6. Drag the Level slider all the way to the right to display 100.

7. Right-click (Windows) or Ctrl+Shift+click (Macintosh) the last 
keyframe.

8. Drag the Level slider all the way to the left to display 0.

9. Click in the Record monitor, and type –5  on the numeric keypad. 
Press Enter on the numeric keypad to move the position indicator 
5 frames before the last keyframe.

10. Click the Add Keyframe button.

11. Drag the Level slider all the way to the right to display 100.

Rendering the Effect

You must render the Picture-in-Picture effect to play it at full speed.

n You must render a non-real-time effect before it can be played. When an effect 
is rendered, the system stores the effect and its media file as a precomputed 
master clip (often referred to as a precompute). The system uses the 
precompute to play the effect at its normal speed.

To render the effect:

1. Click and hold the Fast Menu button between the Source and 
Record monitors.

The Tool palette appears.

2. Click the Render Effect button.

The Render Effect dialog box appears.

Last keyframe First keyframe
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3. Select a drive for the rendered media from the pop-up menu.

4. Click OK.

5. After the effect is rendered, close the Effect Palette.

6. Return to Source/Record mode by clicking the Source/Record 
Mode button.

7. Play the rendered effect.

Creating a Freeze Frame

We’d like to end the sequence with the Saturn logo. To do this, we 
need to create a freeze frame from a static graphic of the logo.

To create a freeze frame: 

1. Load Saturn Logo.pic into the Source monitor.

2. Choose Freeze Frame and 5 Seconds from the Clip menu.

The Select Media Drive dialog box appears.

3. Select a drive.

4. Move the position indicator to the end of the first frame of black 
after Car LS down road.

5. Splice the freeze frame into the sequence as the final clip.
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Screening the Sequence

You’ve made quite a few changes. Now let’s take a look at the 
sequence:

1. Move the position indicator to the beginning of the sequence.

2. Click the Play button.

You’ve completed this tutorial section. In Chapter 10, you’ll learn how 
to add a title to your sequence.
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CHAPTER 10

Creating Titles

In this chapter, you create a title, edit it, and splice it into the sequence. 
This chapter contains the following sections:

• Creating a New Title

• Using Text Formatting Tools

• Saving a Title

• Editing the Title into the Sequence

Creating a New Title

To create a new title:

1. In the Timeline, move the position indicator to the 
second-to-last clip in the sequence, Wagon LS down road.

n Your Avid system saves into a bin each title you create. You can load a title 
into the Source monitor at any time or drag the Title Effect icon from the bin 
to a segment in the Timeline. You can also drag a title from the bin onto an 
existing title in the Timeline; this causes the existing title to be replaced. 

n You can create a new title with or without a sequence in the Timeline. 
However, if you want to create a title with a video background, you can load a 
video clip into the Record monitor to use as a reference frame while you create 
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the title. The video reference frame you select appears in the background of the 
Title tool while you create the title. The reference frame makes it easier to 
position text and objects exactly where you want them and to select colors 
from the frame to use in the text and objects.

2. Choose Title Tool from the Tools menu.

The Title tool opens.

3. Click below the car.

An insertion point appears.

4. Type A different kind of company, and press Enter 
(Windows) or Return (Macintosh).

5. Click underneath the newly entered text, type A different 
kind of car, and press Enter (Windows) or Return (Macintosh).

Using Text Formatting Tools

The text formatting tools control the appearance of text. If a text object 
is selected when you change an attribute, your Avid system 
automatically applies the attribute to the object. The text formatting 
tools allow you to change the font, style, point size, justification, 
kerning, and leading of your title.

Let’s change the formatting of our title text:

1. Alt+click (Windows) or Option+click (Macintosh) the Selection 
tool in the toolbar.

Object selection handles surround the title.

2. Click the Font Selection button, and choose Times New Roman 
from the Font pop-up menu.

3. Click the Font Size button, and choose 36 from the Font Size menu.
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4. Drag the left side of the text object so that the words A different 
kind of company appear on a single line. To drag the right side, 
click the middle handle on the right side of the text object and drag 
it to the right.



93

Repositioning Text

To reposition the title text:

1. With the Selection tool selected, click the title and drag it so that it 
appears centered in the lower half of the screen.

2. Use the arrow keys to move the title one pixel at a time.

3. Center the Title by clicking the Center Text button.

Changing the Color of Title Text

The Color Selection boxes control fill (Fill), shadow (Shad), and border 
(Bord) color respectively.

The following illustration shows the Color Selection boxes.

To change the color of the title text:

1. Click and hold the Color Selection box for fill. 

The Title Tool Color Picker opens.

2. Click a red color.

The color is applied to the title.

Color Selection boxes



94

Adding a Shadow
To add a shadow to the title text, type 3 in the Shadow Depth text box.

The title shadow appears.

Changing the Color of a Shadow

To change the color of the shadow:

1. Click and hold the Color Selection box for Shadow. 

The Title Tool Color Picker opens.

2. Click a shade of white.

The color is applied to the shadow.

Softening a Shadow

To soften the shadow:

1. Choose Soften Shadow from the Object menu.

2. Type 10 in the Shadow Softness text box.

3. Click OK.

The shadow is softened.
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Saving a Title

To save your title:

1. Choose Save Title from the File menu.

The Save Title dialog box appears.

2. Type Saturn in the Title Name text box.

3. Click Save.

4. Close the Title tool by clicking the Close button (Windows) or the 
close box (Macintosh).

The title appears in the Source monitor.



96

Editing the Title into the Sequence

To add your title to your sequence:

1. In the Track Selector panel, make sure the V1, A1, and A2 Track 
Monitor buttons are deselected.

2. Click the V1 Source Track button, and drag it to the V2 Record 
Track button.

3. With the title clip loaded in the Source monitor, mark an IN point 
at the beginning of the clip and an OUT point at 1:00:05:00.

4. In the Record monitor, move the position indicator to the middle 
of the Wagon LS down road clip.

5. Click the red Overwrite button between the Source and Record 
monitors.

This adds the title to track V2.

6. If necessary, trim the title so that it ends at the last frame of the 
Wagon LS down road clip.

7. Play the finished sequence.

You’ve completed this tutorial section. In Chapter 11, you’ll learn 
about outputting video with your Avid system.
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CHAPTER 11

Generating Output

Your Avid system offers you many formats for exporting video and 
audio to other applications. The system also provides tools for 
generating output for individual tracks or entire sequences to multiple 
videotape or audiotape formats. In this tutorial section, you select an 
output format for your project and create a digital cut. This chapter 
contains the following sections:

• Output Options

• Preparing for Output

• Choosing Output Formats

• Quitting and Shutting Down

n To use this tutorial section, you must be able to control the deck through the 
Digital Cut tool. Make sure you’ve properly connected your deck. For more 
information, see the Avid Composer Products Setup Guide.

n Export procedures are described in the Avid Media Composer and 
Film Composer Input and Output Guide or the Help. If you plan to 
transfer the exported files to another Avid system or third-party application, 
see the appropriate section in the Avid Products Collaboration Guide.
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Output Options

You can use your Avid system to output sequences to NTSC, PAL, 4:3, 
16:9, and videotape formats, all from the same 24p or 25p media. In 
addition, you can generate an edit decision list (EDL) to be used in an 
online suite for preparing an HDTV master. You can also output a 
frame-accurate cut list for creating a film negative.

Preparing for Output

After you’ve completed editing your sequence, you’re ready to output 
it. Preparing for video output involves the following procedures:

• Render all non-real-time effects, as described in the Avid 
Media Composer and Film Composer Effects Guide.

• Calibrate and adjust video output levels.

• Calibrate and adjust audio output levels.

• Decide whether you want to generate stereo or mono audio.

• Mix down multiple audio tracks if necessary.

• (Option) Select settings for direct eight-channel audio output.

• Prepare the record tapes.

• (Option) Record reference bars and tone to tape.

• Choose the output format or formats you want.

These procedures are described in the Avid Media Composer and Film 
Composer Input and Output Guide.
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Choosing Output Formats

When you are working in a 24p or 25p project, you can output 
multiple formats for NTSC video, PAL video, and audio formats, all 
from the same 24p or 25p media. You choose the formats you want 
from the Output Formats section of the Digital Cut tool. 

To output a particular format, choose a play rate from the pop-up 
menu in the Output Formats section. The play rate you choose 
determines how the digital cut is recorded. For example, if you choose 
23.976, you tell your Avid system to slow down the play rate to match 
that used during an NTSC telecine transfer. Then, when the system 
records the digital cut, it adds the pulldown frames and re-creates a 
telecine transfer to an NTSC videotape.

For more information 
on film-to-tape 
transfers, see Chapter 3 
of the Avid Media 
Composer and Film 
Composer Input and 
Output Guide.

For NTSC output, your Avid system automatically sets the pulldown 
if necessary and turns on an indicator on the Meridien™ I/O box.

Quitting and Shutting Down

To quit and shut down:

1. Click Quit in the Open Project dialog box.

2. Choose Leave when the system prompts you.

3. Press and hold Ctrl+Alt+Delete, and click Shut Down to shut 
down your system (Windows) or choose Shut Down from the 
Apple menu (Macintosh).

4. After a few seconds, turn off the rest of your hardware.

Congratulations on completing this Tutorial! We hope you’ve enjoyed 
this introduction to the Avid editing process. After mastering these 
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skills, you can proceed to learn more advanced techniques for 
inputting media, adding other effects and titles, and outputting work 
for digital cuts or EDLs.

For further information about any Avid system techniques or features, 
see the Help system, the Avid Media Composer and Film Composer Input 
and Output Guide, and the Avid Media Composer and Film Composer 
Editing Guide.

Avid also recommends that you consult the latest Avid Training
Catalog for complete descriptions and schedules of Avid’s course 
offerings. All classes are led by trained, experienced professionals. A 
variety of hands-on student activities encourage participant learning. 
For more information, call 800-867-2843 or check 
www.avid.com/education.
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Lift/Overwrite 67
Mark IN 50
Mark OUT 51
Overwrite 67, 78
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Trim Mode 75, 78
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D
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locating an audio frame with 64
Digital Cut tool
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25p output formats 99

Digital cuts 12
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product version number 28
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Dual-roller trimming 75 to 78

E
Edgecode display (Timeline) 61
Edit decision list (EDL) 12
Edit points

marking 49
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nonlinear 10
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entering 83
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dissolve 82
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Picture-in-Picture 83
rendering 87
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Trim mode 75, 78
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Segment mode 73
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Extract/Splice-in button 73

F
F1 key 23
Fade-in effect
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Fast Menu button 81
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compared with video editor 12 to 13
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in Help 26

Find tab (Help system)
using 26
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using timecode 54

Finding information with Help 25
Fixed-storage drive
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Font Size button 91
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Frame offset 56
Frame view
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Frames
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Freeze Frames
creating 88

G
Generating output
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preparing 98 to 99

Go to OUT key 55

H
Hardware

starting 19
Heads view 72
Help menu choices 27
Help system

closing 22
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opening 22
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using Help 25
using the Contents tab 25
using the Find tab 26
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Mark Clip 71
Mark IN 52
Mark OUT 53
Play 37
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Lift button 74
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New users
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Projects
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Q
Quitting the application 99
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Real-time effects 87
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Refining edits 66 to 74
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